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About This Manual

This manual provides support for the IBM* Configuration Management Version
Control (CMVC) product for the UNIX** clients. CMVC consists of a CMVC server
and CMVC clients.

Read this manual to learn how to install and configure the UNIX CMVC clients.
The underlying concepts, manipulation of CMVC objects, and CMVC command
syntax are identical for all supported CMVC clients.

Who Should Read This Manual

Anyone who wants to plan for, install, configure, or use the UNIX CMVC clients
should read this manual. This includes administrators, planners, managers, project
leaders, testers, application developers, and technical writers.

If you do not already have a basic understanding of the CMVC environment, you
should read IBM CMVC Concepts before continuing with this manual.

What You Should Know

You should read this manual if you want to install or configure the UNIX CMVC
clients. To install the CMVC clients, you must be familiar with basic operating
system concepts.

How to Use This Manual
This manual is divided into five chapters:
e Chapter 1, “Network Overview” is an introduction to the CMVC environment.

e Chapter 2, “Hardware and Software Requirements” details the hardware and
software requirements for the CMVC clients.

e Chapter 3, “Installing the CMVC Clients” shows how to install the CMVC clients
and configure the client workstation environment for use with CMVC.

e Chapter 4, “Using the CMVC Clients” shows how to start and stop the CMVC
clients using the graphical user interfaces (GUIs) and the command line.

e Chapter 5, “Customizing Your CMVC System” shows how to configure the
CMVC client for your development environment.

For further information about the CMVC clients, refer to the other manuals in the
CMVC library.
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Highlighting Style

The following highlighting style is used in this manual:

Bold Commands, flags, files, directories, field names, and other items

predefined by CMVC are in bold. Valid abbreviations for commands
also are in bold.

Italics Arguments or options whose names or values must be supplied by you

are in italics. Italics are also for emphasis, for the first occurrence in
text of items that are in the glossary, and for titles of manuals.

Monotype Examples of specific data values, examples of displayed text,

messages, menu items that you select to initiate an action, or
information that you should type are in monotype.

Related Publications

You might want to refer to the following CMVC manuals that contain additional
information about CMVC.

IBM CMVC Concepts, SC09-1633, provides the basis for your understanding of
CMVC. It describes in detail the concepts and processes involved in using
CMVC.

IBM CMVC User’s Guide, SC09-1634, describes all CMVC actions, as
implemented in the graphical user interfaces (GUIs).

IBM CMVC User’s Reference, SC09-1597, contains the reference lists, tables,
and state diagrams for CMVC, as well as a description of how the
message-integrated CMVC client uses the Broadcast Message Server (BMS),
to fully integrate with other integrated development environment tools.

IBM CMVC Commands Reference, SC09-1635, describes all CMVC
commands, their syntax and use, as implemented in the command-line
interface.

IBM CMVC Server Administration and Installation, SC09-1631, contains
detailed information needed to install and configure the CMVC servers.

NetLS Quick Start Guide, SC09-1661, provides the information needed to set
up the Network License System** (NetLS**) license control product to work with
CMVC.

Managing Software Products with the Network License System, SC09-1660,
provides the information needed to manage the use of the NetLS license
control product with CMVC.

Managing NCS Software, SC09-1834, provides additional information for
managing the NetLS software.

You may want to refer to your operating system or relational database
documentation while installing or using CMVC.
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Chapter 1. Network Overview

This chapter introduces IBM Configuration Management Version Control (CMVC)
and briefly describes the system configuration, the user interfaces, and the three
main user roles within a CMVC environment.

System Configuration

CMVC consists of four products: CMVC/6000, CMVC for HP** systems, CMVC for
Sun** systems, and CMVC for Solaris** systems. Each product comprises a server
and clients. Designed for use in a networked environment, each of the CMVC
products is based on a client-server model, as shown in Figure 1.

All CMVC clients can be integrated with the HP SoftBench**, HP SoftBench for
Sun, HP SoftBench for Solaris, or IBM SDE WorkBench/6000 environments.

[]

| —
CMVC s erver CMVC c lient

Network

" I,

CMVC c lient CMVC c lient

I0

=

Figure 1. Example of a Client-Server Network of CMVC

A CMVC server is a workstation that runs the CMVC server software that controls
all data within the CMVC environment. Data files are stored in a file system in
combination with a version control system on the CMVC server. All other
development data is stored in a relational database on the CMVC server. A CMVC
client is a workstation that runs the CMVC client software to access the information
and files stored on the CMVC server. With this client-server architecture, users can
access files and project data without having to know where the networked
resources physically reside.
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User Interfaces

The UNIX clients for CMVC supports two graphical user interfaces (GUIs) based on
the OSF/Motif** window manager and a command-line interface.

* A non-message-integrated GUI is provided for operation in your development
environment.

* A message-integrated GUI is provided for operation with the following
environments:

— The IBM AIX* Software Development Environment (SDE) WorkBench/6000
product

— The HP SoftBench, HP SoftBench for Sun, and HP SoftBench for Solaris
products

For more information about the GUIs, see the IBM CMVC User’s Guide.

¢ A command-line interface is provided for use from an operating system shell.
For more information about this interface, see the IBM CMVC Commands
Reference.

Roles in the CMVC Environment

The roles of users within the CMVC environment can be divided into three main
categories:

e System administrator
e Family administrator
e End user

System Administrator
The system administrator is responsible for:

* Installing, maintaining, and backing up the CMVC server
¢ Installing, maintaining, and backing up the relational database used by CMVC
e Planning, maintaining, and configuring all client and server hardware

The system administrator has root access to the CMVC server and database
administration access to the relational database.

Family Administrator
The family administrator is responsible for:

e Planning and configuring CMVC for one or more families
e Managing user access to one or more CMVC families
¢ Maintaining one or more CMVC families

The family administrator has root access to the CMVC server and database
administration access to the relational database.

End User

The end user uses CMVC within one or more families. This user has access to
one or more CMVC clients.
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Chapter 2. Hardware and Software Requirements

CMVC consists of the following products:

 CMVC/6000

e CMVC for HP systems

e CMVC for Sun systems

e CMVC for Solaris systems

Each product comprises a server and clients. This chapter lists the hardware and
software requirements for the UNIX CMVC clients. For information on the
hardware and software requirements for the CMVC servers, refer to the IBM CMVC
Server Administration and Installation manual.

CMVC supports four UNIX clients: the CMVC/6000 client, the CMVC for Sun
systems client, the CMVC for Solaris systems client, and the CMVC for HP systems
client.

Each UNIX CMVC client requires 16MB (MB equals 1048576 bytes) of memory.
The CMVC/6000 client and CMVC for HP systems client require 20MB of direct
access storage. The CMVC for Sun systems client and the CMVC for Solaris
systems client require 30MB of direct access storage.

Requirements for the CMVC/6000 Client
The CMVC/6000 client code requires the following hardware:
e Any IBM RISC System/6000* PowerStation* workstation

* Any high-resolution graphics display (color or monochrome) supported by the
RISC System/6000 workstation

e Any token-ring or Ethernet Local Area Network (LAN) adapter card supported
by the RISC System/6000 workstation that supports Transmission Control
Protocol/Internet Protocol (TCP/IP)

* Keyboard
e Mouse (required for the GUI)
e Printer (optional)

Note: Any Xserver supporting OSF/Motif Version 1.1 and X Window System**
X11R4 can be used as a display for any RISC System/6000 workstation
running the CMVC/6000 client code. Examples include the IBM Xstation
Models 120, 130, and 150.

The CMVC/6000 client code requires the following software:

e AIX Version 3.2 for RISC System/6000 operating system, or later, which
includes TCP/IP and Network File System** (NFS**) software

IBM AlXwindows* Environment/6000 Version 1.2

IBM Software Development Environment (SDE) WorkBench/6000 (only required
to use the message-integrated GUI with the IBM AlIX SDE WorkBench/6000)

Network License System (NetLS) license control product (shipped with CMVC)
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Requirements for the CMVC for Sun Systems Client

The CMVC for Sun systems client code requires the following hardware:

Any Sun SPARCstation** workstation

Any high-resolution graphics display (color or monochrome) supported by the
SPARCSstation workstation

Any token-ring or Ethernet LAN adapter card supported by the SPARCstation
workstation that supports TCP/IP

Keyboard
Mouse (required for the GUI)

Printer (optional)

The CMVC for Sun systems client code requires the following software:

SunOS** Version 4.1.2 or SunOS Version 4.1.3, which includes TCP/IP and
NFS software

NetLS license control product (shipped with CMVC)

HP SoftBench for Sun software (only required to use the message-integrated
GUI with the HP SoftBench for Sun environment)

Korn shell for Sun systems (required for use with the samples and SCCS
migration or import tools)

Requirements for the CMVC for HP Systems Client

The CMVC for HP systems client code requires the following hardware:

Any HP 9000 Series 400, 700, or 800 workstation

Any high-resolution graphics display (color or monochrome) supported by the
workstation

Any token-ring or Ethernet LAN adapter card supported by the workstation that
supports TCP/IP

Keyboard
Mouse (required for the GUI)

Printer (optional)

The CMVC for HP systems client code requires the following software:

HP-UX** Version 9.0, which includes TCP/IP and NFS software
NetLS license control product (shipped with CMVC)

HP SoftBench software (only required to use the message-integrated GUI with

the HP SoftBench environment)
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Requirements for the CMVC for Solaris Systems Client

The CMVC for Solaris Systems client code requires the following hardware:

Any Sun SPARCstation workstation

Any high-resolution graphics display (color or monochrome) supported by the
SPARCSstation workstation

Any token-ring or Ethernet LAN adapter card supported by the SPARCstation
workstation that supports TCP/IP

Keyboard
Mouse (required for the GUI)

Printer (optional)

The CMVC for Solaris Systems client code requires the following software:

Solaris Version 2.3 or a later release of Version 2 operating system, including
TCP/IP, NFS, and SCCS software (for file migration only)

HP SoftBench for Solaris software (only required to use the message-integrated
GUI with the HP SoftBench for Solaris environment)

NetLS license control product (shipped with CMVC)
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Chapter 3. Installing the CMVC Clients

You can install the CMVC clients from tape or CD-ROM. This chapter describes
the packaging for the CMVC clients, the system requirements for their installation,
and the procedures for installing them.

Refer to Chapter 4, “Using the CMVC Clients” and Chapter 5, “Customizing Your
CMVC System” for instructions on starting, stopping, and customizing the CMVC
clients.

Before installing the CMVC clients, you should read IBM CMVC Concepts for a
thorough understanding of components, releases, and files in the CMVC
environment.

How CMVC Is Packaged

The UNIX CMVC clients are packaged on tapes or on one CD-ROM. A tape
includes all the files for one server and one client:

¢ IBM CMVC/6000 server code, IBM CMVC/6000 client code, and NetLS
Runtime Kit for RISC System/6000 workstations

e IBM CMVC for Sun systems server code, IBM CMVC for Sun systems client
code, and NetLS Runtime Kit for Sun SPARCstation workstations

e IBM CMVC for Solaris systems server code, IBM CMVC for Solaris systems
client code, and NetLS Runtime Kit for Solaris SPARCstation workstations

e IBM CMVC for HP systems server code, IBM CMVC for HP systems client
code, and NetLS Runtime Kit for HP 9000 Series 700 workstations

The CD-ROM includes all the files for:

e IBM CMVC/6000 server code

e |IBM CMVC for Sun systems server code

e |IBM CMVC for Solaris systems server code
e |IBM CMVC for HP systems server code

e IBM CMVC/6000 client code

e |IBM CMVC for Sun systems client code

e |IBM CMVC for Solaris systems client code
e |IBM CMVC for HP systems client code

¢ NetLS Runtime Kits for all the platforms

You need to know the installp image names in the CMVC client package only if you
are installing the CMVC/6000 client code. The installp image names for the
CMVC/6000 client code are listed in the following section.

CMVC/6000 Packaging
The CMVC/6000 client consists of:

e The cmvccltstalm Jlanguage .msg installp image, which contains the base
CMVC/6000 client messages and help text, where language, for example, is
equal to En_US for US English.
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e The cmvccltstal.obj installp image, which contains the base CMVC/6000 client
software (the command-line interface programs, the CMVC/6000 client
graphical user interface program, and sample shell scripts).

e The cmvccltintgm language .msg installp image, which contains the additional
messages and help text required to use the CMVC/6000 client in the SDE
WorkBench/6000 environment, where language indicates your chosen
language.

Note: The messages for the message-integrated CMVC/6000 client are
installed in the C language locale. The message-integrated CMVC
client does not require messages in the En_US language locale. As a
result there is no cmvccltingmEn_US.msg  option.

e The cmvccltintg.obj installp image, which contains the additional GUI required
to use the CMVC/6000 client in the SDE WorkBench/6000 environment.

e The NetLS.Ark installp image, which contains the NetLS Runtime Kit for RISC
System/6000 workstations.

The package may also contain update files.

Prerequisite Tasks for Installing the CMVC Clients
For all CMVC clients, you must do the following prerequisite tasks:
1. Log in as root.
2. Install the appropriate operating system for your client:

e For the CMVC/6000 client, install the AlIX Base Operating System (BOS)
Runtime. (It is part of the IBM AIX Version 3 Release 2 for RISC
System/6000 licensed program).

e For the CMVC for Sun systems client, install SunOS Version 4.1.2 or
Version 4.1.3.

* For the CMVC for Solaris systems client, install Solaris Version 2.3.
e For the CMVC for HP systems client, install HP-UX Version 9.0.

3. Install TCP/IP.

4. Install the NFS software.

5. Verify the NetLS license control product is installed on a node on your network.
If the NetLS product and the CMVC client are installed on the same node, do
not complete the following steps. Otherwise, do the following to let the CMVC
client know the location of the NetLS product:

a. Log in as root.
b. Change to the /usr/lpp/ncs/bin directory.
c. Create a file called glb_site.txt if it does not already exist.
d. Add the following line to the file:
ip:node where NetLS is installed
e. Save the file and log out of root.

If you do not have the NetLS license product installed, refer to the IBM CMVC
Server Administration and Installation manual for installation instructions.

8 CMVC UNIX Client Installation and Configuration



CMVC/6000

For the CMVC/6000 client, you must do these additional prerequisite tasks:
¢ |Install the IBM AlXwindows Environment/6000 Release 2 program.

e |f you are using the message-integrated CMVC/6000 client, you must install the
SDE WorkBench/6000 product. The CMVC/6000 client installation procedures
install the SDE WorkBench/6000 licensed program when installing the
cmvccltintg.obj installp image, if the code is available and if the option to
install prerequisites is selected.

» Verify that you have a minimum of 20MB of direct access storage.

CMVC for Sun Systems
For the CMVC for Sun systems client, you must do these additional prerequisite
tasks:

* Install the OpenWindows** program and OpenLook** Window Manager
software.

e If you are going to use the CMVC for Sun systems client in the HP SoftBench
for Sun environment, install HP SoftBench for Sun before installing the CMVC
for Sun systems client.

¢ |Install a Korn shell if you plan to use the SCCS migration or import scripts, or
any of the sample scripts shipped with the CMVC clients. The CMVC for Sun
systems client does not require a Korn shell. However, the SCCS migration
and import scripts and all sample scripts shipped with the CMVC clients must
be run under a Korn shell. If you do not have a Korn shell, you cannot use
these scripts.

These scripts were tested with the UNIX System Laboratories Inc. Korn Shell
Version 88 Release f. No testing was conducted with any other
software-vendor-supplied Korn shell.

¢ Verify that you have a minimum of 30MB of direct access storage.

The CMVC client GUIs are based on the OSF/Motif window manager; however, the
CMVC for Sun systems client can be installed to function with both the OpenLook
Window Manager (olwm) and the OSF/Motif window manager (mwm). Your
window manager must be installed and running before you install the CMVC for
Sun systems client. The cmvcinstall script works with either olwm or mwm.

CMVC for Solaris Systems
For the CMVC for Solaris systems client, you must do these additional prerequisite
tasks:

* Install the OpenWindows program and OpenLook Window Manager software.

e If you are going to use the CMVC for Solaris systems client in the HP
SoftBench for Solaris environment, install the HP SoftBench before installing
the CMVC client.

» Verify that you have a minimum of 30MB of direct access storage.
The CMVC client GUIs are based on the OSF/Motif window manager; however, the

CMVC for Solaris systems client can be installed to function with both the
OpenLook Window Manager (olwm ) and the OSF/Motif window manager (mwm).
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Your window manager must be installed and running before you install the CMVC
for Solaris systems client. The cmvcinstall script works with either olwm or mwm.

CMVC for HP Systems

For the CMVC for HP systems client, you must do these additional prerequisite
tasks:

Install the X Window product and either the OSF/Motif window manager or HP
Visual Environment Window Manager (vuewm ).

If you want to use the CMVC for HP systems client in an HP SoftBench
environment, install the HP SoftBench software before installing the CMVC for
HP systems client.

Verify that you have a minimum of 20MB of direct access storage.

Installing the CMVC Client Code from Tape

This section describes how to install the CMVC client code from tape. To install
the CMVC client code from CD-ROM, see “Installing the CMVC Client Code from
CD-ROM” on page 11.

CMVC/6000

To install the CMVC/6000 client code from tape, do the following:

1.
2.

Log in as root.

Insert the tape containing the CMVC/6000 client installation images into the
tape drive.

. Type the following on the AIX command line:

smit startup

This command starts the System Management Interface Tool (SMIT), which
presents a menu-driven environment for the installation process. For
information on SMIT, see your AlX operating system documentation.

. Follow the directions on the SMIT installation menus, selecting cmvccltstal.obj

for installation.

. Follow the directions on the SMIT installation menus, selecting

cmvccltstalm language .msg, where language, for example, is En_US for US
English. If you do not want to use CMVC/6000 with SDE WorkBench/6000,
this is the final step.

. If you are installing the message-integrated CMVC/6000 client, follow the

directions on the SMIT installation menus, selecting cmvccltintg.obj and
cmvccltintgm language .msg, where language indicates your chosen language.

Note: The messages for the message-integrated CMVC/6000 client are
installed in the C language locale. The message-integrated CMVC
client does not require messages in the En_US language locale. As a
result there is no cmvccltingmEn_US.msg  option.
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CMVC for Sun, Solaris, and HP Systems

To install the client code from tape, do the following:
1. Log in as root.
2. Insert the tape containing the CMVC files into your tape drive.
3. Create a directory for the CMVC client code files, for example, /usr/1pp/cmvc.
4. Determine the device name for your tape drive.

Figure 2 shows common device names for the Sun, Solaris, and HP platforms.
Verify the device name with your system administrator before proceeding.

Tape Mode Sun Device Name Solaris Device HP Device Name
Name

Rewind /dev/rst0 /dev/rmt/Om /dev/rmt/Om

Non-rewind /dev/nrst0 /dev/rmt/Omn /dev/rmt/Omn

Figure 2. Common Device Names for Tape Drives

5. Assuming that TAPEDEYV is the name of the device used to access your tape
drive in a nonrewinding mode, enter the following commands for HP-UX:

cd /usr/1pp/cmvc

mt -t TAPEDEV rewind

dd if=TAPEDEV skip=0 > cmvcinstall
chmod u+x cmvcinstall
./cmvcinstall

Enter the following commands for SunOS or Solaris:

cd /usr/1pp/cmvc

mt -f TAPEDEV rewind

dd if=TAPEDEV skip=0 > cmvcinstall
chmod u+x cmvcinstall
./cmvcinstall

The cmvcinstall script prompts you for the name of the device used to access
your tape drive in nonrewind mode and in rewind mode. You must supply the
correct values to run the installation script successfully.

6. To install either the message-integrated client or the non-message-integrated
client, follow the instructions and answer the prompts presented by the
cmvcinstall  script.

Installing the CMVC Client Code from CD-ROM

This section describes how to install the CMVC client code from CD-ROM. To
install the CMVC client code from tape, see “Installing the CMVC Client Code from
Tape” on page 10.

The CD-ROM contains the software for the CMVC servers and CMVC clients. For
instructions on installing the CMVC servers, refer to the IBM CMVC Server
Administration and Installation manual.
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The terms and conditions for using the CMVC clients are stated in the file
cpyright.inf on the CD-ROM. You can display or print cpyright.inf , which is in
ASCII format, from your workstation.

If you are installing the CMVC for HP systems client, all file names are displayed in
uppercase.

CMVC/6000

To install the CMVC/6000 client code from CD-ROM, do the following:

1.
2.
3.

Log in as root.

Insert the CD-ROM into the CD-ROM drive.
Type the following on the AIX command line:
smit

This command starts the System Management Interface Tool (SMIT) which
presents a menu-driven environment for system administration tasks. For more
information on SMIT, see your AlX operating system documentation.

. Use SMIT to mount the CD-ROM as a file system. Mount the file system into a

directory, such as /cdrom.

. Run the standard software installation procedure from SMIT. Specify the

source directory that you created in step 4.

. Follow the directions on the SMIT installation menus, selecting cmvccltstal.obj

for installation.

. Follow the directions on the SMIT installation menus, selecting

cmvccltstalm /anguage .msg, where language, for example, is En_US for US
English. If you do not want to use CMVC/6000 with SDE WorkBench/6000,
this is the final step.

. If you are installing the message-integrated CMVC/6000 client, follow the

directions on the SMIT installation menus, selecting cmvccltintg.obj and
cmvccltintgm language .msg, where language indicates your chosen language.

Note: The messages for the message-integrated CMVC/6000 client are
installed in the C language locale. The message-integrated CMVC
client does not require messages in the En_US language locale. As a
result there is no cmvccltingmEn_US.msg  option.

CMVC for Sun Systems
To install the CMVC for Sun systems client code from CD-ROM, do the following:

1.
2.

3.

Insert the CD-ROM into the CD-ROM drive.
Log in as root and type the following commands:

mkdir /cdrom

mount -r -t hsfs /dev/sr® /cdrom
cd /cdrom

./cmvcinst

Follow the instructions in the installation script to install the appropriate CMVC
client.

4. After the installation is completed, type the following commands:
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umount /cdrom
eject /dev/sr0

CMVC for Solaris Systems

To install the Solaris systems client code from CD-ROM, do the following:

1. Insert the CD-ROM into the CD-ROM drive. The Solaris volume management
automatically mounts the CD-ROM as /cdrom/cmvc_230.

2. Log in as root and type the following commands:

cd /cdrom/cmvc_230
./cmvcinst

3. Follow the instructions in the installation script to install the appropriate CMVC
client.

4. After the installation is completed, type the following command:
eject cdrom

Note: If volume management is not running, contact your system administrator for
instructions on mounting the CD-ROM.

CMVC for HP Systems
To install the CMVC for HP systems client code from CD-ROM, do the following:

1. Insert the CD-ROM into the CD-ROM drive.

2. Log in as root and use System Administration Manager (SAM) to mount the
CD-ROM as a file system under a directory, such as /cdrom.

3. Type the following commands:

cd /cdrom
./CMVCINST

4. Follow the instructions in the installation script to install the appropriate CMVC
client.

5. After the installation is completed, type the following command:

umount /cdrom

Configuring Your Environment to Use CMVC

A CMVC server can support several CMVC families. After installing the CMVC
client on your workstation, you must configure it for your environment and the
family or families to which you belong. Do the following on each workstation
designated as a CMVC client.

You can find more information about the GUI in the file
usr/lpp/cmvc/bin/README.gui

Chapter 3. Installing the CMVC Clients 13



Verifying Motif Key Bindings for Sun and Solaris

Verify that Motif** keysyms are available before running the CMVC for Sun systems
or CMVC for Solaris systems client. These keysyms reside in the resource file
XKeysymDB . The CMVC version of this file is in the
Jusr/lib/X11/XKeysymDB.cmvc file.

If you do not already have an XKeysymDB file, copy the CMVC version into one of
the following paths:

e For CMVC for Sun systems, into the $SOPENWINHOME!/lib path (for
OpenWindows Version 3.0)

e For CMVC for Solaris systems, into the $OPENWINHOME/lib/X11 path (for
OpenWindows Version 3.0)

If you already have an XKeysymDB file, place it in the appropriate directory and
add the CMVC version information to it.

Setting Your Client Address

Before you can set your client address, you must have the root password for your
workstation.

To set the client address for your workstation, do the following:
1. Log in as root to the designated CMVC client.

2. This step is optional, but if you do not complete it, you must enter the
information manually each time you start CMVC.

Add the following entry to the end of the /etc/services file:
familyname portnumber/tcp

where familyname is the name of your CMVC family, portnumber is the port
number for your family, and tcp is the network type indicator. You must obtain
the family name and port number from your family administrator. For example,
if cmvcfaml is your family name and 1221 is your port number, you would have
the following entry in your /etc/services file:

cmvcfaml 1221/tcp

The 1221 is arbitrary but must be unique and must match the entry in the
/etc/services file on the CMVC server workstation.

3. Add the family name as an alias of the CMVC server workstation in your
TCP/IP naming environment. This is done through the network information
system, a name server, or by changing the entry in your /etc/hosts file. For
example, family cmvcfaml is an alias for the machine cmvcserv, which is the
designated CMVC server workstation. You would have the following entry in
your /etc/hosts file:

cmvcserv  cmvcfaml

4. Log out of root.
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Setting the Path to the CMVC Executables

You must set the path to the CMVC client executable programs and copy the
Cmvc file for the CMVC client to your home directory, as follows:

1. Log in to your system with your operating system login.
2. Add /usr/lpp/cmvc/bin  to the PATH environment variable in the login profile.

3. Copy the CMVC client application resource file, Cmvc, from the
/usr/lib/X11/app-defaults directory to your home directory.

This file stores information such as the colors and fonts you have selected. For
guidelines on customizing CMVC, see Chapter 5, “Customizing Your CMVC
System.” Chapter 5, “Customizing Your CMVC System.”

Note: In CMVC for Solaris Systems, add the following variable for the
integrated client: LD_LIBRARY_PATH=/opt/softbench/lib

Setting Message-Integrated CMVC as Your CM Tool

The SDE WorkBench/6000, HP SoftBench, and HP SoftBench for Sun tools use
the softinit file in the /usr/softbench/config  directory and the .softinit file in your
home directory to control the tools that are started for each of the tool classes.
You can configure these files to designate that CMVC is your tool of the
Configuration Management (CM) class. For more information on how the Tool
Manager performs this control function, refer to your WorkBench or SoftBench
documentation.

Note: Softbench in Solaris is usually installed in /opt/softbench and not
lusr/softbench.

To make CMVC your configuration management tool within the WorkBench or
SoftBench environment, enable the CMVC and Windows menus in the
Development Manager, and direct the Execution Manager to start CMVC in
response to CM messages.

Enabling the CMVC Menus in the Development Manager
To enable the CMVC menus in the Development Manager, do the following:

1. Copy the applications default for the Development Manager into your home
directory:

cp /usr/softbench/app-defaults/Softdm $HOME/.
chmod u+w Softdm

2. Add the following line:
Softdm.menuDirSelect CM: Softcmvc
The next time that you start the Development Manager, the CMVC and
Windows menus are displayed on the menu bar.

For information on enabling menus, refer to your WorkBench or SoftBench
documentation.
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Informing the Execution Manager
You must have an entry in your personal .softinit file indicating the CM tool that
Execution Manager uses. You must also configure the SOFTINIT tool.

If you are the system or family administrator for your group, edit the file softinit in
/usr/softbench/config to specify that CMVC is the Configuration Management tool:

1. Delete the comment character from the first column of the line that says:
CM TOOL HOST * %Local% softcmvc -scope host -host %Host% -class Softcmvc

2. Add a comment character in the first column of any other line that begins with:
CM TOOL

If you are a CMVC user, do the following:

1. Copy the line added to the softinit file to your $SHOME/.softinit file (your
personal WorkBench or SoftBench initialization file). The softinit file is in
lusr/softbench/config.

2. If the Tool Manager is already running, to invoke the softinit process to reread
these files, select SOFTINIT from the scrollable list in the Tool Manager - Start
dialog box.

Bringing SCCS Files into CMVC

If you have been using the Development Manager, you may have been using the
Source Code Control System (SCCS) encapsulation (softsccs) as your
configuration management (CM) tool within the WorkBench or SoftBench
environment. You may also have used SCCS as a version management tool
before using WorkBench or SoftBench environment tools.

If your group has been using SCCS as its CM tool or as an independent program,
you can migrate your files to the database and file system managed by the CMVC
server.

For information on the processes for migrating and importing SCCS files into the
CMVC environment, refer to the IBM CMVC Server Administration and Installation
manual. You should also read IBM CMVC Concepts for a thorough understanding
of CMVC.

Migrating CMVC Version 1.1 Application Defaults

A utility program, migResources , converts the application defaults from the CMVC
Version 1.1 Cmvc and Softcmvc resource files to your current settings. The
conversion includes Section 2 to Section 5 of the Cmvc resource file and Section 2
to Section 6 of the Softcmvc resource file.

Note: In CMVC Version 2.1, both the message-integrated client and the
non-message-integrated client use the same Cmvc resource file.

The migResources program is located in the samples directory. The
migResources program makes the appropriate adjustments for the differences
between CMVC Version 1.1 and CMVC Version 2.1.

To convert your application defaults, do the following:

1. Install the CMVC Version 1.1 Cmvc or Softcmvc resource file in the same way
as it was used with the CMVC Version 1.1 client.
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2. Run the migResources program. Type:
migResources cmvc or migResources softcmvc

All the CMVC Version 1.1 application resources are saved as your current
settings in a file in your home directory.

3. Copy the CMVC Version 2.1 Cmvc resource file, as described in “Setting the
Path to the CMVC Executables” on page 15. Edit this file if you want to
change color defaults. For editing instructions, see “Motif Resources” on
page 28.

4. Start CMVC.
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Chapter 4. Using the CMVC Clients

This chapter helps you to begin using CMVC by describing:

e The information you must get from your family administrator before starting
e The authority that is required to perform CMVC actions

e Starting the CMVC GUI and exiting from it

e Where to get help if you want to use CMVC without the GUI

Before You Start
Before starting the CMVC GUI program, do the following:

1. Ensure that you have a workstation with the TCP/IP and NFS programs running
on it. You also require a login for the host that is your CMVC client.

2. Ask your CMVC family administrator to create a CMVC user ID for you. You
can suggest a user ID that is different to your login. It can be a maximum of
15 alphanumeric characters.

Note: User IDs must be unique within a family.

You must also provide the following information so that a host list entry can be
made for your CMVC user ID:

e Your host hame
e Your login on the host

3. Ensure that your workstation has access to the CMVC client code. If your
family administrator has not done this, refer to Chapter 3, “Installing the CMVC
Clients.”

Authority Requirements
Different authority requirements are attached to each of the many actions that can
be performed using CMVC. There are 5 types of authority influencing the type of
actions you can perform: base authority, superuser privilege, implicit authority,
explicit authority, and restricted authority.

Base Authority
If you have a valid CMVC user ID, you can perform unrestricted actions, such as,
opening defects and features or issuing reports on CMVC development objects.

Superuser Privilege

If you are granted CMVC superuser privilege by a family administrator or someone
else with superuser privilege, you can perform all possible actions in your CMVC
family. This superuser privilege is granted within CMVC. There are some actions
in CMVC that only a superuser has the authority to do, such as, adding or deleting
a user.
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Implicit Authority

You have implicit authority to perform some actions on the basis of ownership. For
example, if a defect is opened for a component you own, you have the implicit
authority to perform certain actions, such as, accepting the defect or modifying the
owner of the defect. Similarly, if you own a component, a release, or a feature, you
have implicit authority related specifically to those roles. You have the implicit
authority until you relinquish ownership of the object in question.

Explicit Authority

You may be granted explicit access authority for a component to perform actions
on certain CMVC objects associated with that component. This provides control
over who can do what in a project. Instead of having to give you authority for each
and every action, your family administrator can group a set of actions under access
authority groups. The component owner can assign you to one or more of those
access authority groups. Component owners cannot, however, give more access
than they have. The authority group or groups to which you belong for any given
component are inherited by all descendant components. The inheritance of explicit
authority can be restricted for any or all users in a CMVC family for specific
components. The specific actions used to create or restrict access authority groups
are listed in the IBM CMVC Server Administration and Installation manual. The set
of predefined authority groups shipped with this product, which your family
administrator may choose to use, are in the IBM CMVC User’s Reference.

If explicit authority is required, you will be told of the specific action you must have
defined in your access authority group, rather than the name of the authority groups
to which you must belong. This is necessary because the access authority groups
can be configured by your family administrator. Superuser privilege is listed only if
a superuser can perform that action.

Restricted Authority

A superuser, a component owner, or a user with AccessRestrict authority can
restrict the access of an authority group for a specific component. The user can
restrict this authority group for all inherited users or for specific inherited users.
Restricted authority is not inherited and does not affect the user’s implicit authority
or superuser authority. For specific information on the authority requirements for
each CMVC action, refer to the IBM CMVC User’s Reference.

Starting the CMVC Graphical User Interface

You must log in on the CMVC client workstation and the CMVC server must be
running. The path to the CMVC client executables must be set. If you have not
already done this, see “Setting the Path to the CMVC Executables” on page 15.
To start the CMVC GUI application from the command line, type the following and
press Enter:

cmvce

The CMVC - Tasks window is opened. The standard X Toolkit options are all
available.
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Starting the Message-Integrated CMVC GUI

CMVC supports a graphical user interface that is integrated with the SDE
WorkBench/6000, HP SoftBench for Sun, HP SoftBench for Solaris, or HP
SoftBench tools through the BMS message interface. With the message-integrated
interface, CMVC functions in the same way no matter which tool you use.

Before you can start the message-integrated CMVC client, it and the CMVC server
must be installed. The SDE WorkBench/6000, HP SoftBench for Sun, HP
SoftBench for Solaris, or HP SoftBench tools must also be configured so that the
CMVC client is the CM tool.

If the CMVC client is not installed, follow the steps in Chapter 3, “Installing the
CMVC Clients” on page 7. For details on customizing the WorkBench or
SoftBench tools, see “Setting Message-Integrated CMVC as Your CM Tool” on
page 15.

You can start the message-integrated CMVC GUI from the Tool Manager, from the
Development Manager, from some of the other development environment tools, or
from the command line.

From the Tool Manager
Use the following procedure to start the CMVC client GUI from the Tool Manager:

1. Select Start from the Tool menu. The Tool Manager - Start dialog box is
displayed.

2. Select CM from the scrollable list of tools available from the Tool Manager.

3. Select the Start button or double-click on CM to start the message-integrated
CMVC client. The CMVC - Tasks window of the graphical user interface
appears.

You can save the selected tool as part of a startup toolset, as explained in your
WorkBench or SoftBench documentation.

From the Development Manager
Ensure that the CMVC and Windows menus are enabled for the Development
Manager. If they are not, follow the instructions in “Setting Message-Integrated
CMVC as Your CM Tool” on page 15.

To start CMVC from the Development Manager:

1. Start the SDE WorkBench/6000, HP SoftBench for Sun, HP SoftBench for
Solaris or HP SoftBench tool. The main window of the Development Manager
appears.

2. Select any action from the CMVC menu or any item from the Windows menu.

a. If you select an action from the CMVC menu, the CMVC - Tasks main
window, the associated window for the selected action, and the dialog box
needed to perform the action are displayed. For example, if you select the
action Check In... from the CMVC menu, the CMVC - Tasks main window,
the CMVC - Files window, and the Check In Files dialog box are displayed.

b. If you select an item from the Windows menu, you see the CMVC - Tasks
main window and the associated window for the selected item.
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For more information on the Development Manager, see your WorkBench or
SoftBench documentation.

From Other WorkBench or SoftBench Tools

When you select a CM tool action, such as, Check In... from one of the other
WorkBench or SoftBench tools, the Tool Manager starts the CMVC GUI, if it is not
already running. The CMVC - Tasks main window, the associated window for the
selected action, and the dialog box needed to perform the action are displayed.
For example, if you select the action Check In... from the Program Builder, the
CMVC - Tasks main window, the CMVC - Files window, and the Check In Files
dialog box are displayed.

From the Command Line

You can start the message-integrated CMVC GUI from the operating system
command line. Make sure that WorkBench or SoftBench are running. To start the
message-integrated CMVC client tool, type the following command and press Enter:

softcmvc -scope host -host hostname -class Softcmvc

The standard X Toolkit options are all available, as are all the standard SDE
WorkBench/6000, HP SoftBench for Sun, or HP SoftBench options, as follows:

-scope [HOST]host]
Specifies the scope of the message-integrated CMVC client. Other
normally allowable values for scope, such as, NET, net, DIR, dir, FILE,
or file are not allowed because the message-integrated CMVC client is a
tool with a host scope.

-host hostname
Specifies the host portion of the tool context. If not specified, the
current host is assumed.

-class name
Specifies the class name of the encapsulated application. The class
name is passed to the SDE WorkBench/6000, HP SoftBench for Sun,
HP SoftBench for Solaris, or HP SoftBench encapsulator.
Message-integrated CMVC has the class name Softcmvc .

A warning message is displayed if the Broadcast Message Server is not running.

You can still use the message-integrated CMVC client but you will not be
communicating with other integrated development environment tools.
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Helpful Hints

This section describes some unexpected messages that may appear when you try
invoking the CMVC client and describes how to respond to them.

Unexpected Messages Responses

The CMVC - Tasks window opens, Type the name of the CMVC family that you want to
but the Set Family Dialog box does access and select 0K. The family you set is saved

too. and used until you change it.
No window is opened, but a Check that your CMVC client is correctly installed on
message is displayed indicating your client workstation.

that the command is not found. Check that you configured your client environment

properly, especially the path pointing to your CMVC
executable programs.

The CMVC - Tasks window is Cancel the Error dialog box and type the CMVC User
opened, but the User ID is not ID that your family administrator created for you in
found. the Set User ID dialog box. The User ID you set is

saved and used until you change it.

Before you exit the CMVC client GUI, you should set
your CMVC User ID properly in the Options menu, or
else you will have to set your User ID each time you
invoke the GUI program.

Windows are too small, too large, Motif resource specification problems. Check your
or are posted in the wrong settings in the Cmvc file.
position.

Figure 3. Problems Starting CMVC and Their Solution

Stopping the CMVC GUI
From any CMVC GUI window:

1. Select Exit from the File menu. You can also press F3 to display the CMVC -
Question dialog box directly. A CMVC - Question dialog box appears, asking
you to respond to the question:

Do you want to exit from the CMVC GUI program?

2. Select Yes. All CMVC windows and dialog boxes are closed.

Stopping the Message-Integrated CMVC GUI

You can stop the message-integrated CMVC client from the GUI or from the Tool
Manager.

From the GUI
From any CMVC client GUI window:

1. Select Exit from the File menu. A CMVC - Question box appears.
2. Select Yes. All open CMVC windows and dialog boxes are closed.
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From the Tool Manager
To stop the CMVC client from the Tool Manager:

1. Select the CM tool in the context that you want from the scrollable list on the
Tool Manager main menu.

2. Choose Stop from the Tool menu. A STOP Request is sent to the CMVC
client. All open CMVC windows and dialog boxes are closed.
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Chapter 5. Customizing Your CMVC System

This chapter describes how to use the customization options of CMVC to tailor the
CMVC client to your development environment.

Use the customization options to:

e Set the GUI application defaults. These defaults are used to specify directory
paths and the CMVC family that you usually work with, and to select the print
command that you want to use. The defaults also control screen refreshes, the
messages that are sent to your terminal, and the expiry time for the NetLS
token.

e Set the tasks in the Tasks window task list. The task list is used to start
frequently performed actions, such as, requesting information from a database.
When you select an item in the task list, the corresponding window is opened
and the action is started.

* Assign a default query to a specific GUI window. These queries are issued
each time the GUI window opens.

e If you are using the message-integrated CMVC client, set the context mapping
options so that information about default directories is passed from the
integrated development environment to CMVC.

* Modify the default Motif resources, such as colors and fonts.

Setting the GUI Application Defaults

The CMVC GUI application defaults provide you with a quick way of initiating
commonly performed GUI tasks, file tasks, and family management tasks. The
default actions are implemented each time you start CMVC.

To set the CMVC GUI application defaults, select Options from the menu bar of
any window. When the pull-down list is displayed, select the default values that
you want to customize. Select 0K to save your selection. The values are saved
and used until you change them.

To customize the GUI, set any or all of the following defaults:

Set Family...
The Set Family dialog box appears with the Family and User ID fields
containing the values you previously set for the family. If you did not set
the values using the Set Family dialog box, then these fields are blank.
Type the name of the family you want to access in the Family field. If
you did not configure the port number for your family in /etc/services
and /etc/hosts , you must fully specify the family name in the following
format:

familyname@hostname@portnumber

For information on configuring the port number for your family, see
“Setting Your Client Address” on page 14.
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Set User ID...
The Set User ID dialog box is displayed, with the User ID field
containing the value you previously set for user ID. This value is
initialized with your workstation login unless you install the GUI program.
If you want to perform actions using a different CMVC user ID, type the
CMVC user ID that you want to use.

Note: To perform CMVC actions using another user ID, your user ID
must be entered on the host list for that user ID.

Set Directory...
The Set Directory dialog box appears with the Directory field filled in.
This value is initialized with the current working directory when you
install the GUI program. Type the name of the working directory that
you want to use.

Set Print Command...
The Set Print Command dialog box appears, with the Command field
containing the value that you previously set for the print command. This
value is initialized with Ipr unless you install the GUI program. Type the
print command that you want to use.

Set Log Filename
Specifies the name of the file that logs a history of all the commands
that you issue while you are using CMVC. This value is initialized with
cmvc.log unless you install the GUI program. Type the filename you
want to use as log file.

Set Expiry Time

Specifies the length of time (in minutes) that the NetLS token is held.
The default and minimum is 15 minutes.

Defining Default Tasks and Queries

Sample tasks are provided with CMVC. You must modify these tasks to make
them relevant to your development environment. You can also define default
queries for a specific CMVC window.

Default Tasks

The CMVC - Tasks window in the GUI application lists default tasks in the client
area of the window. You can use the task list to perform frequently used
procedures and to query the server for information related to a CMVC object.

Customize tasks in the task list using one of two procedures. Use either the Open
List... option provided in any main window, except the Tasks window, or the
options provided in the Tasks window.

Using the Open List Option to Customize Tasks
Use the Open List... option to add a new task to the task list. To add a new task:

1. Select Open List... from the File menu in any main window (except the Tasks
window). The corresponding Open List dialog box is displayed.

2. To define a task, complete the entry fields in the dialog box.

3. To save the task, select 0K.
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4. Then select Current Query from the File menu and select Add to Task List
from the cascade menu. The Add Current Query to Task List dialog box is
displayed, with the Query field filled in.

5. Type a description in the Description field. Select 0K to add the query to the
Task list.

Using Task Window Options to Customize Tasks

Use the options provided by the Actions menu of the Tasks window to create,
modify, or delete tasks from the task list.

To create a task:

1. Select Create... from the Actions menu in the Tasks window. The Create
Tasks dialog box is displayed.

2. Specify the description of the task in the Description field. This description is
displayed in the Tasks window each time that you start CMVC.

3. Specify a query (in valid SQL syntax) for the main window, or type the name of
an executable program in the Task field.

4. To specify whether the task is an SQL query or an executable program, select
the appropriate push button.

5. To specify the name of the main window in which you want the SQL query task
to run, select the name from the pick list.

6. To save the new task, select the 0K push button. If you want to leave the
dialog box open, select Apply instead of 0K.
To modify a task:
1. Select a task from the task list.
2. Select Modify... from the Actions menu of the Task window.

3. Change the task title, window, query, or executable program name in the
appropriate fields.

4. To save the modified task, select the 0K push button.

To delete a task:
1. Select a task from the task list.

2. Select Delete from the Actions menu of the Task window. A prompt box is
displayed and you are prompted to confirm that you want to delete the task.

3. To delete the task, select the Yes push button.

4. If you do not want to delete the task, select the No push button.

Default Queries
You can define a default query for main windows dealing with CMVC objects using
the List view in the GUI application. The default query is issued each time you
open the window.

To define a default query for a main window, select Open List... from the Files
menu of the window. When you finish entering your query, select 0K to save the
query. Then select Current Query from the File menu and select Save as Default
from the cascade menu to save the query.
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Note: Define your queries concisely using valid SQL syntax. If your queries are
too general, you may find that:

e The time required to open a main window increases. This slows down
your application.

e The number of items displayed in the client window increases. If the
resulting list is large, you may have to use the scroll bars extensively to
navigate through the list.

¢ The server overloads and the network bandwidth diminishes.

Customizing the Message-Integrated Client

CMVC stores all versioned files by a path name within a particular release and
component. To convert the file information CMVC receives from the WorkBench or
SoftBench environment, so that the CMVC file name can be identified, you must
enter context mapping information in the Set Context Mapping dialog box. For
more information on context mapping, refer to the IBM CMVC User’s Reference.

To enter context mapping information:

1. Select Set Context Mapping from the CMVC menu in the Development
Manager.

The Set Context Mapping dialog box is opened. The Directory field contains a
value from the Development Manager context.

2. Type information in the following fields:

Release Name of the release associated with the files in the context
directory

Component Name of the component associated with the files in the context
directory

3. Select 0K to save your settings.

For more information on the Set Context Mapping dialog box, refer to the /IBM
CMVC User's Guide.

Motif Resources

The Cmvc resource file contains the Motif resources, such as, colors, fonts and
keyboard focus information. All CMVC clients use the Cmvc resource file.

Edit the resource file to customize the appearance (such as, color) and behavior
(such as, the size and location) of the CMVC client windows and dialog boxes. For
example, the font defaults for the CMVC for Sun systems client are screen.r.12. If
you prefer a different font, run the following command to see the fonts available for
your workstation:

x1sfonts
Replace the screen.r.12 entry in your Cmvc file with the font that you prefer.

For more information about the Cmvc file, see “Setting the Path to the CMVC
Executables” on page 15.
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Glossary

This glossary contains definitions of data processing
terms that might be unfamiliar to you. It includes terms
and definitions from the IBM Dictionary of Computing,
New York: McGraw-Hill, 1994.

A

access list . A set of objects that controls access to
development data. Each object consists of a
component, a user, and the authority that the user is
granted or is restricted from in that component. See
also authority, granted authority, and restricted
authority.

action . A task performed by the CMVC server and
requested by a CMVC client. A CMVC action is the
same as issuing one CMVC command.

authority . The right to access development objects
and perform CMVC commands. See also access list,
base authority, explicit authority, granted authority,
implicit authority, restricted authority, and superuser
privilege.

B

base authority . The set of actions granted to a user
when a user ID is created within a CMVC family. See
also authority. Contrast with implicit authority and
explicit authority.

Broadcast Message Server (BMS) . A facility that
coordinates the SDE WorkBench/6000 or HP SoftBench
tools. Messages from tools are sent to the Broadcast
Message Server, which routes the messages to other
tools.

C

check in . The return of a CMVC file to version control.

client . A functional unit that receives shared services
from a server. Contrast with server.

CMVC client . A workstation that connects to the
CMVC server by a TCP/IP connection and that is
running the CMVC client software.

CMVC file. A file that is stored by the CMVC server
and retrieved by a path name and release. See also
file, common file, and shared file.

common file . A file that is shared by two or more

releases, and the same version of the file is the current
version for those releases. See also shared file.
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component . A CMVC object that organizes project
data into structured groups, and controls configuration
management properties. Component owners can
control access to development data and configure
notification about CMVC actions. Components exist in
a parent-child hierarchy, with descendent components
inheriting access and notification information from
ancestor components. See also access list and
notification list.

configuration management The process of
identifying, managing, and controlling software modules
as they change over time.

context . A description of a data file or directory in the
form host dir file. That is the host machine, working
directory, and file. See tool context and message
context.

current working directory (1) The directory that is
the starting point for relative path names. (2) The
directory in which you are working.

D

database . A organized collection of data that can be
accessed and operated upon by a data processing
system for a specific purpose.

default . A value that is used when an alternative is not
specified by the user.

default query . A database search, defined for a
specific CMVC window, that is issued each time that
CMVC window is opened. See also search.

defect. A CMVC object used to formally report a
problem. The user who opens a defect is the defect
originator.

delete. If you delete a development object, such as, a
file or a user ID, any reference to that object is removed
from CMVC. Certain objects can be deleted only if
certain criteria are met. Most objects that are deleted
can be re-created.

E

end user. See user.
environment . A user-defined testing domain for a

particular release. Also used as a defect field, in which
case, it is the environment where the problem occurred.
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explicit authority The ability to perform an action
against a CMVC object because you have been granted
the authority to perform that action. Contrast with
implicit authority and base authority.

F

family . A logical organization of related development
data. A single CMVC server can support multiple
families. The data in one family cannot be accessed
from another family.

family administrator A user who is responsible for all
nonsystem-related tasks for one or more CMVC
families, such as planning, configuring, and maintaining
the CMVC environment and managing user access to
those families.

feature. A CMVC object used to formally request and
record information about a functional addition or
enhancement. The user who opens a feature is the
feature originator.

file. A collection of data that is stored by the CMVC
server and retrieved by a path name. Any text or binary
file used in a development project can be created as a
CMVC file. Examples include source code, executable
programs, documentation, and test cases. See
common file and shared file.

G

graphical user interface (GUI) The OSF/Motif-based
CMVC graphical user interface program.

H

host. A host node, host computer, or host system.

host list . A list associated with each CMVC user ID
that indicates the client hosts that can access the
CMVC server and act on behalf of the CMVC user.
The CMVC server uses the list to authenticate the
identity of a CMVC client when the CMVC server
receives a CMVC command. Each entry consists of a
login, a CMVC user ID, and a host name.

host name . The identifier associated with the host
computer.

implicit authority The ability to perform an action on
a CMVC object without being granted explicit authority.
This authority is implicitly granted through inheritance or
object ownership. Contrast with base authority and
explicit authority.
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inheritance . The passing of configuration
management properties from parent to child component.
The configuration management properties that are
inherited are access and notification. Inheritance within
each CMVC family or component hierarchy is
cumulative.

L

level. A collection of tracks that represent a set of
changed files within a release. Levels are only
associated with releases whose processes include the
track and level subprocesses.

login . User identifier.

M

message context . The Broadcast Message Server
uses a context field to pass file name information
between the various SDE WorkBench/6000 or HP
SoftBench tools. The context is made up of the host,
dir and file.

N

NetLS. Network License System.

Network File System (NFS) . A program that enables
you to share files with other computers in one or more

networks over a variety of machine types and operating
systems.

Network License System (NetLS) A program that
controls the number of users who can simultaneously
access CMVC.

notification list A CMVC object allowing component
owners to configure notification. A list of user
ID-interest group pairs attached to a component,
designating users and the corresponding notification
interest they are being granted for all objects managed
by this component or any of its descendants.

O

owner. The user who is responsible for a CMVC
object within a CMVC family, either because the user
created the object or was assigned ownership of the
object.



P

path name . The name of the file under CMVC control.
A path name can be a set of directory names and a
base name or just a base name. It must be unique
within the release that groups the files.

process . A combination of CMVC subprocesses,
configured by the family administrator, that controls the
general movement of CMVC objects (defects, features,
tracks, and levels) from state to state within a
component or release. See also subprocess and state.

Q

query . A structured request for information from a
database, for example, a search for all defects that are
in the open state. See also default query and search.

R

release. A CMVC object defined by a user that groups
all the files that must be built, tested, and distributed as
a single entity.

restricted authority The restriction of a user's ability
to perform certain actions at a specific component.
Authority can be restricted by the superuser, the
component owner, or a user with AccessRestrict
authority. See also authority.

S

scope . A parameter in the TOOL statement for each
SDE WorkBench/6000 or HP SoftBench tool. It defines
the fields in the message context used by the Execution
Manager to determine whether a tool can service a
request.

search. To scan one or more data elements of a set in
a database to find elements that have certain
properties.

server . A workstation that performs a service for
another workstation.

shared file . A file that is shared between two or more
releases. See also common file.

SMIT. System Management Interface Tool.

subprocess . CMVC subprocesses govern the state
changes for CMVC objects. The design, size, review
(DSR) and verify subprocesses are configured for

component processes. The track, approve, fix, level,

and test subprocesses are configured for release
processes. See also process and state.

superuser privilege This privilege allows a user to
perform any action available in the CMVC family. Note:
Superuser privilege is internal to CMVC and not related
to operating system superuser authority.

system administrator A user who is responsible for
all system-related tasks involving the CMVC server,
such as installing, maintaining, and backing up the
CMVC server and the relational database it uses.

System Management Interface Tool (SMIT) An AIX
tool used to perform system administration tasks, such
as installing software or creating logins for new users.

T

task list . The list of tasks displayed in the
CMVC-Tasks window. The user can customize this list
to issue requests for information from the server. Tasks
can be added, modified, or deleted from the lists.

TCP/IP. A set of communications protocols that
support peer-to-peer connectivity functions for both local
and wide area networks.

tool. An SDE WorkBench/6000 or HP SoftBench
application.

tool context . The range of data for which a tool is
registered to receive requests and perform actions.

toolset . A set or configuration of tools. You can save
and restore a toolset to replicate a particular SDE
WorkBench/6000 or HP SoftBench environment with the
Tool Manager.

Transmission Control Protocol/Internet Protocol
See TCP/IP.

U

user. A person with an active CMVC user ID and
access to one or more CMVC families.

user ID. The identifier assigned by the system
administrator to each CMVC user.

Vv

version control The storage of multiple versions of a
single file along with information about each version.
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CMVC (continued)

roles 2

server 1

system configuration 1

tasks 2

user interfaces 2
CMVC user IDs

See user IDs
command

highlighting style viii

print 26

syntax vii
component 20
configuring

environment to use CMVC 13

etc/hosts 14

etc/services 14

Motif resources 28

Task window list 26
context mapping 28
customizing

appearance and behavior of windows 28

Development Manager 15

D

database 1, 16
defect 20
Development Manager
enabling the CMVC menus 15

starting the message-integrated client

dialog boxes

Set Directory 26

Set Expiry Time 26

Set Family 23, 25

Set Log Filename 26

Set Print Command 26

Set User ID 23, 26
directory

mapping 28

setting from Options menu 26
disk space requirements 3

E

end user 2
environment variables 15
explicit authority 20

F

family
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family (continued)
setting in etc/hosts 14
setting in etc/services 14
working with multiple families 25
family administrator 2, 19
feature 19
file
associating with releases and components 28
migration from SCCS 16
storage on server 1
font defaults 28

G

graphical user interface (GUI)
application defaults 25
customizing appearance 28
types in CMVC 2

GUI (graphical user interface)
See graphical user interface (GUI)

H

hardware requirements
CMVC for HP systems 4
CMVC for Solaris systems 5
CMVC for Sun systems 4
CMVC/6000 3
disk space 3
memory 3

highlighting style viii

home directory 15

host 19, 22

host list 19, 26

HP SoftBench 4, 15

HP SoftBench for Solaris 5, 15

HP SoftBench for Sun 4, 15

implicit authority 20
inheritance 20

installation
CD-ROM 11
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tape 10

interfaces, CMVC 2

K

Korn shell 9

L
log file 26
login 19
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manuals
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Motif resources 28
multiple families 25
multiple user IDs 26

N

NetLS (Network License System)
manuals viii
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Network File System (NFS) 8, 19
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network overview 1
NFS
See Network File System (NFS)
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OSF/Motif 2, 28

P

packaging 7
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pull-down menus
See menus

R

requirements 3
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migrating from CMVC V1R1 16
Motif 28
Tasks window list 26

restricted authority 20

SCCS (Source Code Control System)

Korn shell requirement 9
migrating files to CMVC 16



SDE WorkBench/6000 3, 15
setting user IDs 26
SMIT
See System Management Interface Tool (SMIT)
SoftBench
See HP SoftBench
softcmvc
adding to .softinit file 16
starting from command line 22
software requirements
CMVC for HP systems 4
CMVC for Solaris systems 5
CMVC for Sun systems 4
CMVC/6000 3
Source Code Control System (SCCS)
See SCCS (Source Code Control System)
superuser privilege 19
system administrator 2
System Management Interface Tool (SMIT) 10, 12

T

Tasks window list 26
TCP/IP (Transmission Control Protocol/Internet
Protocol)
installing 8
requirement for 3, 19
Tool Manager
starting the message-integrated client 21
stopping the message-integrated client 24

U

user IDs
creating 19
setting 26

working with multiple 26
user interface 2

V

version control 1, 16

W

windows
changing appearance and behavior 28
configuring tasks 26
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